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PREFACE

Punjab School Education Board has been updating the school level syllabi
compatible with modern approach and latest research. The previously written text-
books are in continuous process of revision according to the latest syllabi. The Board
has also launched a special derive to prepare new text books as per latest National
Policies in this regard. The present book is a part of this prestigious program.

The knowledge in the subject of Computer Science is the need of the hour because
its study is essential for enhancement of efficient usage of Science and Technology in
every field of modern era. Computerization of every department is done to keep it
updated in light of all round development of Information Technology and
Communication. The knowledge of Computer Education as well as usage of internet is
necessary for everyone to have latest information about different departments, to avail
facilities of E-Ticketing etc.

Keeping in view of these requirements Punjab School Education Board has
introduced Computer Science as a compulsory subject at Elementary and Secondary
levels as per guidelines of Punjab Government. This subject is already being taught by
PICTES in some Government Schools. The present book is English translation of its
Punjab version prepared according to revised syllabus on the demand of teachers.
Every effort has been made to include each requisite information regarding the subject
in this book. I hope it will be useful for students and teachers.

All suggestions for the improvement of the book will be highly appreciated.

Chairman

Punjab School Education Board
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LESSON

Introduction to Computer

Objective of this Chapter
1.1 What is a Computer?
1.2 Definition of Computer
1.3 What can we do on a Computer?
1.4 Applications of a Computer
1.5 Characteristics of Computer

1.6 Limitations of a Computer

Introduction

Computer has become very important nowadays because it is very much
accurate, fast and can accomplish many tasks easily. Many of our day to
day activities are based on computer. Computers are used in Schools,
Banks, Hospitals, Shops, booking counters of Railways and Airlines,
Education and Entertainment. The term computer is derived from the Latin
term 'computare’, this means “to calculate”. Computer cannot do anything

without any instruction.

1.1 What is a Computer ?

Computer is an electronic machine. It is
designed to work with Informations. It
receives Data and Instructions from user.
The process of giving Data and

Instructions to Computer is called Input.

Computer processes the input. After
processing computer gives us result which Fig. 1.1 Computer

is called Output.
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1.2 Definition of Computer

“Computer is an electronic machine that takes data as input from the
user and processes these data according to the set of instructions called
program and gives the result (output). It saves output for the future use. It
can process both numerical and non-numerical calculations”.

1.3 What can we do on a Computer?
A computer can perform the following functions:-
We can do mathematical calculations on computer.
We can check spelling of a text on Computer.
We can draw pictures on Computer.
We can use Computer to print books and newspaper.
We can play games on Computer.
We can listen songs and see films on Computer.

We can book our tickets to travel in Trains, Buses and Airplanes.

® N o 0k LW D=

We can check arrival and departure time of Trains, Buses and
Airplanes.

9. We can check the weather conditions of a place before travelling.
10. We can prepare reports, results of our school or time table.

11. We can search the map of a place where we wish to travel.

1.4 Applications of a Computer
Computers are used in many fields. Some of the following fields are:-
1.4.1. In Education field
1.4.2. In Health and Medicine field
1.4.3. In Shops
1.4.4. In Business
1.4.5. In Banks
1.4.6. In Entertainment field
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1.4.7. In different Government fields.
1.4.8. In Sports

Let us learn about the use of computers in different fields in detail :

1.4.1 In Education field

Computers are widely used in teaching by teachers and students.
Teachers use computer to make lesson plans, reports and time table. The
students use computers for drawing, making projects and to solve different
kinds of problems quickly and efficiently. They use computers to collect
different information about education on the Internet.

Fig. 1.2 In Education Field
1.4.2 In Health and Medicine field :

Nearly every area of health and medicine uses computers. For example,
in hospitals computers are used for maintaining patient history and other
records. They are also used for patient monitoring and diagnosis of diseases
etc. Computer is also used in hospital laboratories to perform different
medical tests.

Fig. 1.3 In Health and Medicine
1.4.3 In Shops

Computer is also used in shops. On computer, a shop keeper can keep
the records of goods which is available in his shop. He can maintain the
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record of tax and record of sales-purchase on a computer. Nowadays many
shopkeepers maintain bills of sales-purchase with the help of computers.

Fig. 1.4 In shops

1.4.4 In Business

Computers are very helpful in business also. With the help of computers
a businessman can contact his clients using email. A businessman can take
meetings with his clients using Video Conferencing. With the help of
computers he can maintains his books of accounts.

Fig. 1.5 In Business

1.4.5 In Banks

Computers are widely used in banks. They are used in banks for record
keeping and maintaining accounts of customers. Most of the banks provide
the facility of ATMs (Debit Card). The customers can withdraw and deposit
money in his account through ATM (Debit Card) at any time.
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1.4.6 In Entertainment field

Computer is also helpful in our Entertainment. With the help of
Computers a computer designer can give special effects in movies. With the
help of computes even imaginary characters (cartoons) can play a part in

making movies, videos, and commercials.

Fig. 1.7 In Entertainment

1.4.7 In different Government fileds

Various departments of the Government use computer for their
departmental planning, control and law enforcement activities. Computers
are widely used in Traffic, Tourism, Information & Broadcasting,

Education, Aviation and many other sectors.

Fig 1.8 In Government Sectors

1.4.8 In Sports

Computers are mostly used in Sports also. In cricket some scoreboards
are manually update but nowadays most professional sports venues have
very modern scoreboards that update scores and information immediately
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after the information is entered into the computer and display result to
audiences.

Fig. 1.9 In Sports

1.5 Characteristics of a Computer

As we know that a Computer is a very useful machine. It has many
characteristics as described below :

1.5.1. Speed

1.5.2. Accuracy

1.5.3. Diligence

1.5.4. Versatility

1.5.5. Automation

1.5.6. Storage

Let us learn about the characteristics of computer in detail :

1.5.1. Speed

Computer can work very fast. It takes only few seconds for calculations
that we take hours to complete. We will be surprised to know that a
computer can perform millions of instructions and even more per second.

1.5.2. Accuracy

The degree of accuracy of computer is very high and every calculation is
performed with the same accuracy. The errors in computer are due to
human and inaccurate data because in whatsoever manner data and
instructions are fed into computer, it processes the data and instructions in
the same manner.

1.5.3. Diligence

A computer is free from tiredness, lack of concentration, fatigue, etc. It
can work for hours without creating any error.
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1.5.4. Versatility

It means the capacity to perform completely different type of work. We
may use our computer to do calculations and on the same time we may use
it for inventory management or to prepare Sale/Purchase bills and listening
songs.

1.5.5. Automation

Once the instructions are fed into computer it works automatically on it
without any human intervention. It works till the completion. It executes
the program until it meets logical instructions to terminate the job.

1.5.6. Storage

The Computer has an in-built memory where it can store a large amount

of data. we can also store data in secondary storage devices such as CD's,
DVD's and USB Pen Drives.

1.6 Limitations of Computer

Although a computer is very fast, powerful and accurate machine, but it
has the following limitations :

A computer cannot generate information on its own.
A computer cannot correct wrong instructions.

A computer cannot come up with its original decision.

LN =

Computer cannot do any work without getting instruction from the
user.

It does not have feelings or emotion like a human being.

6. It does not have knowledge and experience like a human being.

( Points to Remember )

Computer is an electronic machine.

Computer gives accurate result if right instructions are given
Computer never gets tired
Computer is versatile machine.

Computer possess no intelligence

AL S o

Computer has no feelings or emotions
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(_Exercise )

Fill in the Blanks using the right option :

............... is an electronic machine.
(1) Cycle (2) Typewriter  (3) Computer (4) All of these.

The speed of computeris ............... :
(1) Fast (2) Slow (3) Medium (4) None of these.

Computer has very large ............... .
(1) Speed (2) Memory (3) Display (4) Keyboard

In business computers are used to prepare ............... .

(1) Cash (2) Tickets

(3) Books of account (4) None of these

Computers are used in Education by ............... and ............... .
(1) Teachers, students (2) Businessman, Banker

(3) Parents, children (4) all of these

Write down True or False :

Ol L N =

Computer can perform Mathematical Calculations.
Computer cannot take decision itself.

Computer doesn't have storage capacity.

A computer cannot correct wrong instructions.

Computer is an electronic machine which receives input, processes
it and gives output.

Short Answer type Questions :

O WD N =

What is a Computer?

Give definition of Computer ?

What can we do on a Computer ? Write any four.
How a Computer is helpful in Health and Medicine ?
How a Computer is helpful in Banks ?

Long Answer type Questions :

1.
2.
3.

Write down about the fields where a Computer can be used ?
Write Down characteristics of a Computer.
Write Down the limitations of a Computer.
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Functioning of Computer

Objective of this Chapter
21 Block Diagram of a CPU
2.2 Types of Computer

Introduction

We have learnt that a Computer is an electronic machine. It can process
data, pictures, sound and graphics. It can solve complicated problems
quickly and accurately. A computer performs basically five major computer
operations. These are :

1. It accepts data or instructions by way of input.
It stores data.
It process data as required by the user.

It gives results in the form of output.

AR

It controls all operations inside a computer.

Before studying about Block Diagram of CPU we need to learn about
the functions of a computer in detail. Let us learn about basic functions in
detail :

Basic Functions of Computer :

1. Input : This is the process of entering data and programs in to the
computer system. We know that computer is an electronic machine. It
receives data and instructions as input.

2. Storage : The process of saving data and instructions permanently is
known as storage. We need to feed data into the computer system before
the actual processing starts. Because the processing speed of Central
Processing Unit (CPU) is so fast. So the data has to be provided to CPU
with the same speed. It provides space for storing data and instructions.
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The storage unit performs the following major functions :
w All data and instructions are stored here before and after processing.
w Intermediate results of processing are also stored here.

3. Processing : After input computer takes action on data. The task of
performing operations like arithmetic and logical operations on data is
called processing.

4. Output : This is the process of producing results from the data for

getting useful information. Similarly the output produced by the computer
after processing must be kept inside a place in a computer is called Storage.

INPUT —> PROCESS —> OUTPUT

Vo

STORAGE

Fig. 2.1 Basic Functions of Computer

2.1 Block Diagram of CPU

In this section we will learn about the functioning of a computer system.
CPU Stands for Central Processing Unit and it's the most important part of
a computer system. As we have learnt that firstly we give Input (data) to

C.p.U.
1

Computer System then this data is processed and finally we get Output.
Programand Data
Keyboard/ Memory Monitor/
—— . ——p —_—
Mouse » Unit Speaker
n - Results
Control T i
Unit
Arithmetic
Ml Logic Unit

BLOCK DIAGRAM OF CENTRAL PROCESSING UNIT
Fig.2.2
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Basically Central Processing Unit is divided into three separate units for
its operation. These are :

2.1.1. Memory unit
2.1.2. Control Unit
2.1.3. Arithmetic logic unit.

Let us learn about the brief detail of Central Processing Unit.

2.1.1 Memory Unit

The Memory Unit is the part of the computer that holds data and
instructions for processing. Although it is closely associated with the CPU
but in actual fact it is separate from it. Memory associated with the CPU is
also called primary storage or primary memory. Whatever software we
load into a computer system from a floppy disk, hard disk or CD-DVD
ROM, firstly it is stored in the Main Memory.

There are two types of computer memory inside the computer:
2.1.1.1. Primary Memory
21.1.2. Secondary Memory.

2.1.1.1 Primary Memory

Primary memory is known as main memory. It is of two types: RAM
and ROM. It is the only one directly accessible to the CPU. The CPU
continuously reads instructions stored there and executes them as required.
RAM is used to store data on temporary basis, such as we input a data. As
soon as the computer system is switched off or in case of power failure, the
information hold in RAM is deleted, that's why it also called Volatile
Memory. ROM stores the instructions and information that is required by a
computer to start on. In case of Power failure or computer system is
switched off the data stored in ROM doesn't get deleted. ROM can be re-
programmed. Primary Memory has limited storage capacity. It is very
expensive. It is not easily portable.

ROM : Random Access Memory
RAM : Read only Memory

2.1.1.2 Secondary Memory

Secondary memory is called auxiliary memory. It contains all data
storage that is not currently in a computer's primary storage or memory.
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This is computer memory that is not directly accessible to the processor. It
is for storing data not in active use and keeps data even without power. So
it is called non-volatile memory. Hard disk is a good example of secondary
memory that is fixed in a computer system. CD, DVD or USB Pen Drive
also few examples of secondary memory. It is not so costly. Its storage
capacity is more than primary memory. It is easily portable.

2.1.2 Control Unit

The control unit is also called a control system or central controller. It
directs the various components of a computer, such as receiving input,
giving instructions to store data and producing results. It reads and
interprets (decodes) instructions in the program one by one decodes each
instruction and also control the other parts of the computer. Some of its
basic functions are as follows :

1. To read the code for the next instruction.
2. To decode the numerical code for the instruction .

3. To provide the necessary data to an ALU.

2.1.3 Arithmetic Logic Unit:

An arithmetic logic unit (ALU) performs arithmetic and logical
operations. The ALU is a building block of the central processing unit
(CPU) of a computer because the instructions are executed here. ALUs can
perform the following operations :

1. Integer arithmetic operations (for example : addition, subtraction,
multiplication and division).

2. Bitwise logic operations (greater than, smaller than, equal to)

2.2 Types of Computer

Types of computers are based upon the purpose, functioning and size of
the computer. Accordingly they are classified into four types :

2.2.1. Micro Computer (Personal Computer)
2.2.2. Mini Computer.
2.2.3. Mainframe Computers

2.2.4. Super Computer
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Let us study in details about these types of Computer:

2.2.1 Micro Computer (Personal Computer)

Microcomputers are the most common type of
computers used by people nowadays. These
Computers are used in a workplace, at school or

at home.
These computers include :
2.2.1.1. Laptop

It is a portable personal computer. It is light in
weight and small enough that it is easy to
operate it on a person's lap. A laptop computer
has its own battery and can be charged easily as
required. A person can carry a laptop while

travelling.

2.2.1.2. Notebook

It is a portable computer smaller than a
laptop. Likewise Laptop Computer It is light in
weight. A notebook computer has its own
battery and can be charged easily as required. A

Person can carry it while travelling.

2.2.1.3. Palmtop

It is a computer that has a small screen and
compressed keyboard. It is small enough to be
held in the hand. It is often used as a personal

organizer and stores message, contacts etc.

Fig. 2.3 Micro Computer
(Personal Computer)

Fig. 2.4 Laptop

Fig. 2.6 Palmtop
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2.2.1.4. Tablet

It is a very thin portable computer. It is
usually battery-powered. It has a touch screen as
the primary interface and input device. It doesn't

have a physical keyboard and lid like a laptop.

2.2.2. Minicomputer

A minicomputer is a class of multi-user
computers. It is a type of computer that
possesses most of the features and capabilities of
a large computer but is smaller in physical size.
Minicomputers are mainly used in scientific

applications

2.2.3 Mainframe Computers

These computers are capable of handling and
processing very large amounts of data quickly.
These Computers are capable of performing high
processing speed and data storage but not
powerful as super computers. Mainframe
computers are used in large institutions such as

government banks and large corporations.

2.2.4 Supercomputer

A super computer is most powerful
computer. It has fastest speed and very high
processing speed. It has large data storage. Super
computer is specifically used for complex
applications by big organization. Super
computers are costly.

Fig. 2.8 Minicomputer

Fig. 2.9 Mainframe
Computers

Fig. 2.10 Supercomputer
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( Points to Remember )

Computer accepts data and instructions by way of input.
Computer can process data as required by the user,
Computer gives results in the form of output.

CPU Stands for Central Processing Unit

Basically a CPU is divided into three separate units for its operation.
They are :

w  Memory unit

w  Control unit.

w Arithmetic logic unit

The control unit is often called a control system or central controller.
Memory associated with the CPU is also called primary memory.
Secondary memory, sometimes called auxiliary memory.
Computers are classified into four types :

w  Micro Computer (Personal Computer)

w  Mini Computer

w Mainframe Computers

w  Super Computer

10. Super Computer is most powerful computer available in the world.

( Exercise )

Fill in the Blanks using the right option :

............... is the process of entering Data and Instructions to the

computer.
(1) Input Devices (2) Output Devices
(3) CPU (4) None of these

The process of saving data and instructions permanently is known

(1) Input (2) Storage (3) Processing  (4) Output
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3.

5.

The process of producing results from the data for getting useful
information is called ............... .

(1) Input (2) Output (3) Processing  (4) None of these

Primary storage is also known as................ Memory.
(1) Secondary (2) Main (3) Auxiliary  (4) All of these

Secondary storage is also called.................... storage.
(1) Secondary (2) Main (3) Auxiliary  (4) all of these

Write down True or False :

1.
2.

>

A computer is an electronic machine.

The Process of entering data and programs into the computer is
called Output.

Intermediate results of processing are stored in Storage.
A super computer is most powerful computer.

Memory is of two types : Primary Memory and Secondary
Memory.

Short Answer type Questions :

AN S o e

Draw the diagram of basic functions of a Computer.

Draw Block Diagram of C.P.U. and name three parts of it.
Define memory and name of two types of memory.
Differentiate between Primary memory and Secondary memory.
Describe about Laptop.

What is Tablet?

Long Answer type Questions :

1.

O LN

What are the basic functions of a Computer?

Ditference between Primary Memory and secondary memory?
Describe Control Unit.

Describe A.L.U.

Describe Microcomputer.
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Introduction to Windows

Objective of this Chapter

3.1 What is an Operating System ?

3.2 How to Start a Computer ?

3.3  What is Desktop ? Icons, Taskbar and Shortcut.

3.4 What are Icons ?

3.5 What is Taskbar ?

3.6 Parts of Windows : Title Bar, Menu bar, Toolbar, Scroll Bar

3.7 How to Turn off a Computer ?

Introduction
We have learnt that a Computer is an electronic machine. Likewise other
machines we need to start a Computer. Many of us can work easily on a

Computer, but we don't know how to start a Computer ?

In this chapter we will learn how to start a Computer ? We will learn
about various objects visible on a screen after starting a computer. We will
also learn about Operating System that acts as a link between a user and a

computer.

3.1 What is an Operating System ?

The operating system is the most important program that is on a
computer. The operating system basically runs the computer and allows
other programs to run as well. The operating system does all the basic
functions that a computer needs to do, such as getting inputs from the

mouse or the keyboard. It prevents unauthorized access to the computer.
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3.1.1 Definition of Operating System

“An operating system is a software program that enables the computer
hardware to communicate and operate with the computer software.”

Operating System is available in many types such as Microsoft
Windows, Linux Operating Systems and Macintosh Operating System. The
most popular Operating system today is Microsoft's Windows operating
system. In this chapter we will study about Microsoft Windows 7.

3.1.2 Windows

Windows is an Operating System. It is installed on a Computer System.
It provides us Graphical User Interface (GUI). So it is very easy to operate
Computer with the help of a Mouse. We can easily run a Program that is
installed on it. A window is called a window because of its shape,
whenever we click on a program; it opens in a frame like a window.

3.2 How to start a computer ?

The Steps to turn on the computer are described below:

1. Switch on the Power Switch of CPU and Monitor. We will see a blink
of light on our keyboard and see some text on our computer screen.
Now The Operating System will start Loading in computer. This
process is called Booting. Wait till the booting process is completed.

Fig 3.1 How to Start a Computer
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After booting the following screen will be displayed to us:

Fig. 3.2 Screen after Booting

As shown in Fig. 3.2 we need to press Alt, Ctrl and delete keys
simultaneously from our key board. After this we will see the following
screen :

Fig. 3.2.1 Log on Screen

Logging-on to our computers : If we have server based “N-Computing”
Computer lab in our school then we need to press Alt, Ctrl and delete keys
simultaneously from our key board. After this we will see log on screen as
shown in Fig 3.2.1. In this chapter the default username for server is
“School”. For log on to server we need to click in username box and type
“School” after this we need to type “p@1” as password. Now press Enter
key from keyboard. if we are using Clients Computers then we need to type
userl, user2 user3, user4 and userb respectively in username box to log on
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according to our seating position. The password is “p@1” for all
computers. It must be remembered that we should not log on same user on
different clients.

If there is no server based “N-computing” Lab in our school, then we
will see Fig. 3.2 on each computer screen. To log on computer we need to
do the following tasks :

1. Press Ctrl, Alt and Delete key from computer keyboard, we will see
the screen as shown in Fig. 3.2.1.

2. There can be two or three username on this computer. We can logon
any of the one username as per our requirement. To log on we need
to click in username box and type the prescribed username (e.g.
“School”, user1 etc). After this type “p@1” in password box.

3. Press enter key.

After log on to computer, we will see the following screen that consists
of some shapes and a long bar lying down the bottom of the screen. This
screen is called Desktop.

Icons Desktop Task Bar

Fig. 3.3 Desktop
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3.3 What is Desktop ? Icons, Taskbar and Shortcut

Desktop is the basic screen that is visible after completion of Booting
process. All the programs of the windows are run with the help of Desktop.
Desktop have the following three parts :

w [cons
w Taskbar

w  Shortcut

3.4 What are Icons ?

Icons are like small pictures on Desktop. Icons act like button. Icons
represent folders and files. To open a folder or file we have to click its icon
twice e.g. if we double click My Computer icon then My Computer

windows will open. Some examples of desktop icons are shown below :

(3

Computer NeRvoTrE School RecyeleBin

Fig 3.4 Icons
1. My Computer
2. Network
3. User's Files (School)
4. Recycle Bin

Let us study about these icons in detail :

3.4.1 My Computer

With the help of My Computer Icon we can see everything available in
Computer. It has many files, folders and Drives. My computer window
opens when we double click on My Computer Icon.

3.4.2 Network

This icon is available on the Desktop. We can see our network settings
by opening this icon and we can set it as per our requirement.
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3.4.3 User's Files (School)
This icon is used to save the files created or downloaded by us. We can
save our files and folders too in this folder. When we double click on this

icon, we will see the following display :

5 M B B M E R KR N RBD
her il ; -
AppData Contacts Dresktop Downloads Favorites Lirtks Iy My Music My Pictures My Videos Saved Searches
Documents Games

Fig. 3.5 User's Files (School)

3.4.4 Recycle Bin

All the deleted files and folders are stored in the Recycle Bin. Whenever
we don't need a file or folder we delete it from its location, but it is not
deleted permanently from the computer but it goes to Recycle Bin. To

delete a file or folder permanently we have to delete it from Recycle Bin too.

In case we have deleted a file or folder by mistake then we need not to
worry about it. We can get back the deleted file or folder from Recycle Bin.
This process is called Restore. To do this we need to open Recycle Bin and
then select deleted file or folder in it. Then press Restore this item, the

selected file or folder will go back to its original location. (See fig 3.6)

Organize ~ Empty the Recycle Bin Restore this item

e Favoribes - Post Matric Scholarship 2014-15
' @__1 I {version 1) I. WPDNSE

Bl Desktop File folder

. Downloads

Microsoft Office Excel 97-2003 W...

- Recent Places

Fig. 3.6 Recycle Bin

3.5 What is Taskbar ?

The Task bar is the thin strip that runs across the bottom of wer screen. It

has a number of different areas like a start button, Quick launch icons,
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active programs, a notification area and date & time. The image below

shows where the different areas are :

Clock &

Start Button Quick launch Icons Notification Area Date

:-. : . = 3 T " . ™ - Jl ‘
System Tray Show Desktop
Active Programs

Fig. 3.7 Task Bar

With the help of Start - button we can run any program. On the right
side of the Task bar we will see System Tray . Button ,Notification area,
Computer Network Icon, System Sound icon and Date and Time is
displayed. There is one more area on the Taskbar that is easily overlooked-
the Show Desktop button. In the above image we can see a narrow
rectangle to the right of the clock. By clicking on this button we can

minimize all open programs and access the desktop.

Note : Task Bar is also called Super bar because of Show Desktop Button.

3.5.1 Shortcut

If we want easy access from the desktop to our favorite files or
programs, we can create shortcuts to them. A shortcut is .
an icon that represents a link to a program/file/folder,
rather than the program/file/folder itself. When we
double-click a shortcut, the program/file/folder opens. If

we delete a shortcut, only the shortcut is removed, not the
original program/file/folder. We can identify shortcuts

by the arrow on their icon. Fig. 3.8 Shorteut

3.6 Parts of Windows: Title Bar, Menu bar, Toolbar, Scroll Bar

When we open a program, it opens in a shape of frame. This frame is
called Windows. Windows has many components. Different programs

Downloaded from https:// www.studiestoday.com



Downloaded from https:// www.studiestoday.com

open in their different windows. Components of each window are almost

same.

= » v | 4y W Semch Cooputer f=)
Fide Edat Wiew Teook Help
Qeganize = System propenties Urinstall or change a program Map network dma » I H O
o Name i Type Totsl Seze Free Space
BE Desktop
. # Hard Disk Drives (3)
o Librames i
" Documents s Local Disk (C:) Local Disk 781 GB 639G8
o Mutic (s Local Disk (D) Local Disk 168 11268
- Prctures a Local Disk (E) Local Disk 1GE 276 GB
H videos " # Devices with Removable Storage (2)
o Homegroup w2 Floppy Dk Drve (&) Flopp, Dok
. TouTnr L] OVD RW Drve (F:)
o\ AppData
i Contacts
i Deslaop
& Downloads
L . z
g DHANVIN-PC Workgroup: WORKGROUP hemory: 1.00 GB
2 Processer PentiumiR) Dual-Core

Fig. 3.9 Parts of Windows

Let us learn about different components of My Computer Windows :

3.6.1. Title Bar
3.6.2. Menu Bar
3.6.3. Tool Bar
3.6.4. Scroll Bar

Let us study about these parts in details :

3.6.1 Title Bar

It appears at the top of the windows. On the right side following buttons
are present :

1. Minimize Button ( [s=n ) : It is used to minimize the windows. When
we click this button the windows attains the shape of a button on the
taskbar.

2. Maximize Button ( [ ) : This button is located in the middle. It is
used to spread the windows on the whole of the screen.

3. Restore Button ( &k ) : We can change the window to its old shape
while clicking on this Button is (before maximizing the windows)

4. Close Button (€38 ) : This button is used to close the windows.
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3.6.2 Menu Bar

This bar contains generally used commands in windows. When we click
on any option in this bar, we will see drop down menu.

3.6.3 Toolbar

It contains buttons for the commands which are commonly used.

3.6.4 Scrollbar

This bar lets a user to scroll the contents of the window to see
information that is currently out of view

3.7 How to Turn off a Computer ?

If we have completed our work, then we should know how to turn off
our computer properly. Close all the open programs before shutting down
off our computer. Let us learn how to turn off/shut down our computer :

1. Click on “Start Button”, Start menu will be opened. (see in Fig. 3.10)

2. Click on “Shut Down” on start menu. (see in Fig. 3.10)
'i!,s Microsoft Office Word 2007 v E rl‘

.t /] Paint »

O Internet Download Manager

9 Windows Media Center

1] Getting Started »
4{1 Computer
|| Caleulator

Control Panel
Sticky Notes

‘% Snipping Tool

t‘) Remote Desktop Connection

Devices and Printers

Switch user
Log off
Lock

» Al Programs
Restart

| Search programs and files A [Srorasem ™

|
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After some time our computer will shut down.
Note : Always close all the running application before shut down our
computer. Always shut down our computer with above method. Never

shut down our computer directly from Power Switch.

( Points to Remember )

Primary Screen of Computer is called Desktop.

N

Small pictures showing program, files and folders on the desktop are
called Icons.

My computer icon is used to see files, folders and Local Drives.
All the Deleted files are stored in Recycle Bin.

Task bar is also called Super bar.

AN

Show Desktop Button is used to minimize all open programs and
access the desktop.

7. We should not Shut Down our Computer Directly from Power
button.

(' Exercise )
1. Fill in the Blanks using the right option :

1. The Primary screen (first to open) of computer is called ............. :
(1) My Network (2) Icon
(3) Desktop (4) Recycle Bin

2. The bar lying at the bottom of the desktop is called ............... :
(1) Title Bar ~ (2) Status Bar ~ (3) Task Bar (4) Scroll Bar

3. The bar present at the top of the window is called ............... .
(1) Title Bar ~ (2) Status Bar ~ (3) Task Bar (4) Scroll Bar

4. Deleted filesgoto ............... .
(1) My Network (2) My Documents
(3) My Computer (4) Recycle Bin
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5. button is used to close the window.

(1) Minimize (2) Maximize (3) Close (4) Start

Write down True or False :

Windows is an Operating System.

Primary Screen of windows is called My Computer.
My computer helps us to see drives of my Computer.
Maximize button helps us to enlarge the window.

My Documents icon contains files and folders.

SN S o e

We should turn off our computer directly from power button.

Short Answer type Questions :
What is an Operating System?

What is windows?
What is a window desktop?
What are icons? Name any three icons.

Name different components of windows.

AL N

Write down about Show Desktop button on Task bar.

Long Answer type Questions :
1. Explain Task Bar.

2. Explain the following icons.
3. What is Recycle Bin?
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LESSON

ﬂ Introduction to M.S. Paint

Objective of this Chapter
41 What is Paint
4.2 How to start the MS-Paint
4.3 Parts of a Paint Window
43.1 Title Bar
4.3.2 Quick Access Toolbar
4.3.2.1 Moving Quick Access Toolbar
43.3 Menu Bar
4.3.4 Vertical and Horizontal Scroll Bar
435 Status bar
43.6 Work Area
44 Saving the work

Introduction

Paint is a drawing program used for drawing objects and shapes. We
can draw colorful pictures with paint. These pictures can be saved and
printed. These pictures can be copied in another document and can also be
taken to desktop as background.

4.1 What is Paint?

Paint is a drawing tool which helps us to create drawings. It is a useful
program for new users and children. There are many different tools in paint
used for making beautiful pictures. Drawings in paint can be either in
black-and-white or in color, and can be saved as bitmap files. We can print
these drawings, can use it for your desktop background, or paste it into
another document. We can use Paint to work with pictures, such as .jpg,
.gif, or .bmp file formats.

4.2 How to start the MS-Paint
Start ":E“ => All Programs => Accessories => Paint W
L OR P

1. Click on the start button on taskbar/super bar. Start menu will appear.
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Click on All Programs, another menu will appear.

3. Click on Accessories option in this menu. Another menu will appear.
This menu has a Paint option.

4. Click on Paint option.

5. Paint window as shown in diagram given below.
Paint Quick Access Home &  Title Home Tab Minimize

Button Toolbar View Tab  Bar Ribbon Maximize/Restore
H9¢ y‘ _ v )
wene frSow w
- ., 100 — | I | llllu
7 QA ~OODC =
g el <! Bnice » # 2 :'i{" : o _._'_- ',\:-, ! :‘f"' . m -

s ) Uatte

[ ]

Cursor Selection  Image Work Scroll Zoom
Position Size Size Area Bar Slider

Fig. 4.1 Parts of Paint Windows

4.3 Parts of a Paint Window
Paint window is shown in above figure. It has following main parts:
Title Bar
Quick Access Toolbar
Menu Bar
Vertical and Horizontal Scroll Bar
Status bar

Zoom in zoom out
Work Area

NSO
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4.3.1 Title Bar

The title bar is present at the top of the paint window. At the left end of
the Title Bar the first item shown is little paint palette. If we click this button
a standard window menu opens, having options Restore, Move, Size,
Minimize, Maximize and Close. Another thing we will see the title of our
picture followed by the name of the programPaint. If we haven't saved our
picture, the name will be shown as "Untitled".

P8 3 = diUntitled

Fig. 4.2 Title Bar
4.3.1.1 Quick Access Toolbar

Quick Access Bar, contains four buttons - Save, Undo, Redo and
Customize.
4.3.1.2 Minimize, Maximize / Restore, close:

Title bar has three buttons on its right corner. They are:

= Minimize button : used for minimizing the paint window onto the
task bar.

= Maximize/Restore button : used for maximizing and restoring the
paint window.

w Close Button : used for closing the paint window.

a3

Fig. 4.3 Minimize, Maximize, close

4.3.2 Quick Access Toolbar

It is toolbar present in title bar by default. Its position can be changed
both to below or above the ribbon and icons can be added and removed as
per the user's requirement.

& e
Fig. 4.4 Quick Access Toolbar
4.3.2.1 Moving Quick Access Toolbar to below the Ribbon

If we prefer to have Save, Undo and Redo below the ribbon, move your
cursor over the title bar until the Customize icon lights up. Click and a
menu will appear. Near the bottom of the menu that appears, we will see
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Show below the Ribbon. Click Show below the Ribbon. The Quick Access
Toolbar will move below the Ribbon.

IHH ¢ MR -

Fig. 4.5 Moving Quick Access Toolbar to below the Ribbon

We can add more options such as New, Open, and Print Preview etc. to
the Quick Access Toolbar with the help of Customize icon.

| Curvtnmiee Qoick Arcess Toolba
Mew
| Dpen
! v Save
Frimt
Print pieview
Zang in e-mall
i undo
i ¥ Rede
Showe tielow the Ribnon

MEmiaee (e Biblicn

Fig. 4.6 Customize Quick Access Toolbar
Let us learn about these commands and their functions :

Name of Command Functions

New Creates a new, blank image file.

Open Opens a dialog box to open (view) an existing
image file.

Save Saves changes to the current file.

Print Use to Print the current picture.

Print Preview Displays the image on screen as it will appear

when it is printed out on paper.

Send in e mail In Paint Send a copy of the picture in an email as
an attachment.

Undo Undo last action.

Repeat Redo last action.
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Name of Command Functions
Show below/ Shows Quick Access Toolbar below or above the
above the ribbon ribbon.

Minimize the ribbon | Toggle the ribbon On/Off.

We can click any of these items a second time to undo changes we have

made to the Quick Access Toolbar.
4.3.2.2 Adding Ribbon items to the Quick Access Toolbar:

Many other items from the ribbon can also be added to the Quick Access
Toolbar. On the Ribbon, right click on anything we like to add. A menu will
appear which includes the option “Add to Quick Access Toolbar”. Click on
this option.

H %S¢ R A L] ransparent selection 5

Fig. 4.7 Adding Ribbon items to the Quick Access Toolbar

Here the Magnifier, Pencil, Color2 (background color)and Transparent
selection tools have been added to Quick Access Toolbar. To remove these
items we have added from the Ribbon, right click the unwanted icon and

then click the Remove from Quick Access Toolbar option.

4.3.3 Menu Bar

The Menu bar has three tabs named as Paint Button, Home tab ribbon
and View tab ribbon, on the left side and a Help button at the far right side

of the bar as shown in the figure below.
Home Wiew
Fig. 4.8 Menu Bar
4.3.3.1 Paint Button :

The first on the left of the Menu Bar is the Paint Button, which opens a

menu, as shown below, and a list of pictures we have recently saved.
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Untitled - Paint

-
‘] i Recenl picluies
e | 2

1 sr

‘ﬁ ofien 2 dowinioad
- 3 thCASSNME:

4 fieetil
=P

5 reive

§ Untitled
% Save a3 »
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8 Dbaider singh 9th b
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Fig. 4.9 Paint Button

Here we can see some new commands which are discussed in table

shown below :

Name of Command

Functions

Save As

Saves changes to the current file, and allows us to
pick a new or different file name and format such
as PNG, JPEG, BMP, GIF or other format for the
file.

From scanner and
camera

Import picture from scanner or camera.

Set as desktop

Set the current picture as our desktop background.

background
Properties Change the properties of the picture. The
Properties dialogue box will give us information
about the picture on which we're currently
working.
Exit To close paint window.
4.3.3.2 Home tab Ribbon

All the tools, shapes, the color palette, and most commands are grouped

together in the ribbon except the commands such as Save, Undo and Redo,
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which are shown at the left end of the title bar, in the Quick Access Toolbar.
Drop-down arrows below each item in the ribbon will give us access to
everything in their menus. For everything we do in paint, we will need the
Home tab. The Home tab contains the Ribbon, from which tools, shapes,

brushes and colors are selected.

|~/ O]~ 7 outline - |
OAANM v| L Fill -
< O 0D

Shapes

Image

Fig. 4.10 Home tab Ribbon

There is also an option to minimize the ribbon. If we choose this, the

ribbon disappears entirely, but pops into view if you click on the Home tab.

4.3.3.3 View tab Ribbon

We can use the View tab by clicking on it. The options such as Zoom in
and Zoom out, show or hide and display are in View tab. Zoom in and out
can be used alone or in conjunction with the Zoom Tool on the Ribbon or
the slider on the Status Bar.

H-~- Home View

i iDRuIers ;E’ __jIJ' |
i | [ eridiines L

Zoom Zoom 100 Full Thumbnail
in out % Status bar | gereen

Zoom Show or hide Display

Fig. 4.11 View tab Ribbon

4.3.4 Scroll Bar

Scroll Bar is used to move the screen. It is of two types

4.3.4.1 Horizontal Scroll bar

It is present at the bottom of the Paint window and above the status bar.
It moves the screen left and right.

4.3.4.2 Vertical Scroll bar

It is present on the right side of the Paint window. It moves the screen
up and down.
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4.3.5 Status Bar

The Status Bar is present at the very bottom of the Paint Window; it
gives information and can be used to help us as we work in Paint. Let us
look at its features from left to right.

|+ 95,420px T} 25 26px 10 768 x 480px Size: 18.6KB 100% (=) {J ® |

Fig. 4.12 Status Bar

= Cursor Position : It gives the Cursor Position, which is helpful when
we want to position any picture precisely.

+ 95, 420px

Fig. 4.13 Cursor Position

w Selection Size : It shows the size of a selection we are making, or of
an object we are drawing.

123 25 x 26px

Fig. 4.14 Selection Size

w Image Size : It shows the size of our entire picture, even if the
picture is very large and is not all visible in the window. If we have
not changed the wunits in the Properties dialogue box the
measurement will be in pixels, but we can change the measurement
to inches or centimeters.

10 768 = 480px

Fig. 4.15 Image Size

= Disk Size : Once we have saved our picture, this option will show its
size on storage Disk. In a very small window, this figure might not
be shown.

Size: 22.5KE

Fig. 4.16 Disk Size

w Zoom Slider : The Zoom Slider is convenient if we are working in a
zoomed-in view and want to zoom out. However, we cannot zoom
in on a particular spot, as we can do with the Magnifier.

100% (=) ) )

Fig. 4.17 Zoom Slider
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4.3.6 Work Area

Free space is called work area. It is used for making drawing,.

4.4 Saving our Work

It is good to save our picture as soon as we begin to work. We must click
on the Save button on the Quick Access Toolbar every few minutes. This
saves loss of work if the program closes unexpectedly, as in a power failure.

When we click the Save for the first time, we will find a dialogue box
where we have to type a name for the picture. Having typed a name, click
the Save button.

Save as : With the help of Save as option we can Save a Copy of picture
with another file name. Go to the Paint button and open the menu.

Fig. 4.18 Paint button
Click Save as

In the dialogue box, just change existing name then click the Save button.

Save as

( Points to Remember )

Quick Access Toolbar is present in title bar by default
New Command creates a new, blank image file

The first on the left of the Menu Bar is the Paint Button
Maximize, Minimize and close button are parts of title bar.

S N

The Status Bar is present at the very bottom of the Paint Window.

( Exercise )
1. Fill in the Blanks using the right option :

1. The............... bar is present at the top of the paint window.
(1) Title bar (2) Status Bar
(3) Scroll Bar (4) All of these
20 toolbar present in title bar by default. Its position can

be changed either to below or above the ribbon.
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(1) Quick access bar (2) Status Bar (3) Scroll Bar (4) Task Bar

The first on the left of the Menu Bar is the ............... Button.

(1) Paint (2) Help (3) Close (4) Minimize
Scroll Bar is used to move the screen. Itisof ............... types

(1) 2 (2)3 (3)4 4)5

With the help of ............... option we can Save a Copy of picture

with another file name..

(1) save as (2) open (3) new (4) exit

Write down True or False :

1.

Drawings in paint can be saved as bitmap .bmp files.
There are 3 buttons at the Right hand side of The title bar.

Minimize button is used to minimizing the paint window onto the
task bar.

New command is used to create a new, file.

Drawing is done in drawing area.

Short Answer type Questions :

Gk L=

What is paint?

How to start the Ms Paint.

Write the parts of paint window.
Write the types of scroll bar.

What is work area?

Long Answer type Questions :

1.

ARl A

What is Quick Access Toolbar? Explain its parts.
What is paint button? Write down its commands.
Define Home Tab Ribbon.

What is status bar? Explain its parts.

How to save our work?
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M.S. Paint - Part 2

Objective of this Chapter
5.1 Home Tab Ribbon
5.1.1 Clipboard
5.1.2 Image
5.1.3 Tools
5.1.4 Brushes
5.1.5 Shapes
5.1.6 Size
5.1.7 Colors
5.2 View Tab Ribbon
5.2.1 Zoom
5.2.2 Show or Hide
5.2.3 Display

5.1. Home Tab Ribbon

Many of the tools we use in Paint are found in the Home Tab Ribbon,
which is below the Menu Bar of the Paint window. The following figure

shows the Ribbon and main parts of Home Tab Ribbon.

B

Clipboard|| Image | Tools | |[Brushes

-

Size

Fig. 5.1 Home Tab Ribbon

5.1.1 The Clipboard Menu
The clipboard menu has three options - Cut, Copy and Paste. Only

when a selection is active, the Cut and Copy icons are shown as active.
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4 X
& | paste |
f"_,z PR x -
Paft £ - lE Paste
Paste
Clipboard | = [@ Paste from

Fig. 5.2 The Clipboard Menu
Paste is always active, because we may wish to Paste from a picture on
our computer. For example if previously, we have drawn and saved a small
flower and wish to add it to our new drawing. We can click the down
arrow under Paste, click Paste from and navigate to the saved picture, click
its name and click Open.

5.1.2 The Image Menu - Select

Depending on the size of our window, the Image Menu will look like
one of figures shown below. When we click the down arrow just below the
dotted rectangle, or just below the word Image, a menu offers us further
choices.

.....

Rectangular selection

.....

Free-form selection

’ 7ot | H =7 z D Select all
| ¢ :-*3* Invert selection
Select
Im::nge . A 7< | Delete
Image Transparent selection

Fig. 5.3 The Image Menu — Select
Before we can use the buttons on the right of this menu, we must select
the part of our drawing that we want to work with.
w Transparent selection : At the bottom of the Select menu we can see
Transparent selection. We may use this often, so it is good to add it
to our Quick Access toolbar. To do this, right click on Transparent
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selection and then click on Add to Quick Access toolbar. On our
Quick Access Toolbar, there will be a checkbox in front of the words,
Transparent selection, as shown in figure below.

| Transparent selection

Fig. 5.4 Transparent selection

While that box has a tick in it, selections will be transparent. To make
our selections opaque, just click the checkbox to remove the tick.

w Rectangular selection : Usually we can make a rectangular selection.
After clicking the rectangular selection tool, position the cross-hair
cursor at the top left of the part we want to select, press your left
mouse button and drag down to its bottom right. A dashed rectangle
will appear around our selection. With the move cursor %D we can
move our selection, or drag while holding the Ctrl key to make a
copy of it.

w Freeform selection : We may need to make a freeform selection if the
part of our drawing that we want to work with is crowded up
closely with parts we don't want to include.

5.1.2.1 Copying a selection

There is a Copy button on the ribbon for copying, but we can make
multiple copies of a selection in a faster way also.

Draw a selection around the part we want to copy, using either the
rectangular or the freeform selection tool. Whenever Move Cursor G{ED
appears; hold the Ctrl key as we begin to drag to its new location, Click, a
copy will appear of the selection. If we want to continue copying, press the
Ctrl key again as we begin to drag the second time. Repeat as many times
as we needed.

5.1.2.2 Painting with a selection

Select a small piece from a picture, for example, with more than one
color. Hold down the Shift key while we drag it around to make an abstract
pattern. We can even write with a small selection.
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5.1.2.3 Selection option

To the right of the selection icon we can see three options, Crop, Resize
and Rotate flip.

5.1.2.3.1 Crop

The top button, a diamond shape with a line through it is crop. It helps
us crop to our picture so that only the selected area remains. If we click the
Save icon after cropping to a selection, our large drawing page will be
replaced with the cutout.

5.1.2.3.2 Saving a cutout
1. Save the picture we are working on.
Select the part we want to save as a cutout.
Click the Crop button.
Go to the Paint button and open the menu.
Click Save as [&] soveas .

Type a name for the cutout and click Save. We will return to the

AL

Paint window with the cutout displayed in it and the name on the
Title bar is the name we used when saving the cutout.

5.1.2.3.3 Resize and Skew

The second small button to the right of the large Select button will open
the Resize and Skew dialogue box as shown in figure below.

Ll |zeal Kd |

Select r%s | # | Brushes | Shapt
| I Tk ? Q. - .

Imzge Thitnls
T s A Trensparent selection. =

Resize and shew (Chrl+W)

Resize and skew the picture ar
selection,

Fig. 5.5 Resize and Skew

5.1.2.3.3.1 Resize

We can quickly resize a selection by dragging any of the little blocksor
handleson the selection rectangle. However, if we want the size adjustment
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to be precise, we must use the Resize and Skew dialogue box, which will
appear when we click the Resize icon as shown in figure below.

-
Resize and Skew

Resize

By: (@ Percenf tage ) Pixels
+—r FEETTIFETTITITOTE
[ ] Horizontal: 100

D T Verticat 100

Maintain aspect ratio

Skew (Degrees)

& Horizontal: 0
ﬂl Vertical 0
[ ox ]| cance |
Fig. 5.6 Resize

Only the top half of this dialogue box is concerned with resizing.

Note : While the option Maintain aspect ratio is checked, whatever we
type into the Horizontal slot will be repeated in Vertical and our selection
will stay exactly in proportion. We can remove the check if we want the
selection to be fatter or thinner.

o
1
I
1
o
1
:
1

a

-_—— -0 - - - -
|
T
-_—_—_-g----

i
s

5.1.2.3.3.2 Skew

The bottom part of the Resize and Skew dialogue box invites us to skew
our selection. When we use this option, it makes our selection include a lot
of border area to avoid having part of the picture cut off. If this does
happen, click Undo and make a wider selection before trying again.

. s

Fig. 5.8 Skew
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This above blue box show in fig 5.8 is skewed 20 degrees horizontally.
We can skew a selection both horizontally and vertically.

5.1.2.3.4 Rotate or flip

This menu helps us making mirror images of selections, either vertically
or horizontally, and it also helps us in rotating an item 90 degrees.

"k Rotate right 90°
A7 Rotate left 90°
Ji  Rotate 180°

= Flip vertical

4k Flip horizontal

Fig. 5.9 Rotate or flip

Making a mirror image is easy if we are trying to draw anything that
looks symmetrical. We have to just copy half of the picture, flip it and join it
to itself.

= Invert Color : Another set of options are available if we right click on
a selection we have made. It includes Cut, Copy, Paste, Crop, Select
all, Invert selection, Delete, Rotate and Resize, the only one option
that is available on this menu and nowhere else is Invert color. It
helps in making a black mask with white lettering to create a fancy
till for text. Invest color always shows opposite color of our selection
for e.g. if we select black color then use invert color, it will show as
white color.

—
id

L]

[ i
L

b ]
b=

=

LI

il &

Seleckal

L1

Lert salectinm

[elete

X

Al

k Fobmie ¥
dl  Resize
o et colo

Fig. 5.10 Invert Color
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5.1.3 The Tools Menu

/& A
£ 2Q

Tools

Fig. 5.11 Tools Menu
5.1.3.1 Pencil

The pencil tool is used for free-hand drawing, or it can be used for pixel-
by-pixel editing in a zoom-in view.

v

Fig. 5.12 Pencil

When we work with the pencil tool, we must press the left mouse button
to draw with Color 1 and with the right mouse button to draw with Color 2.

Note : Color 1 in Paint is referred to as the Foreground color, and Color
2 is the Background color of the picture. We can also change the pencil's
thickness in the Size tab to 1, 2, 3 or 4 pixels or with the use of ctrl + '+'
button to increase the size or ctrl + '-' to decrease the size.
5.1.3.2 Fill with Color

The Fill with color tool, is used to fill an area with a single color. Color 1
is used if we press the left mouse button on the area to be filled. Color 2 is
used if we press with the right mouse button.

o
Fig. 5.13 Fill with Color

This tool does not work successfully if we are trying to color different
shades of one color. The Fill with Color tool always fills with a solid color.

5.1.3.3 The Text Tool

Like earlier versions of Paint, The Text tool is used to insert our text.

A

Fig. 5.14 Text Tool
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To begin inserting text, click on the text tool. Our cursor will change to an
insertion bar.With this cursor, drag to draw box that we think will be
needed to hold our text. Now we must not click anywhere outside that box.

The Text Toolbar appears as shown in figure below :

View Text
A
Lucida Console T ﬂ
|’.&.’ Tlanspalent|
% B I U ake|

Font Background

Fig. 5.15 Text Toolbar
Now we can type our text.
Formatting the text :
1. Select the text we have typed.
2. Click the down arrow at the end of the Font Name box, so that a list
of fonts drops down.

3. Move your cursor - without pressing any mouse buttonsup and
down in the font list. As we do this, the appearance of the text we
have typed will change accordingly. When we like what we see, click
on the name of that font.

The font list will close.
We can repeat this process with the Font Size list also.

6. We can also click the Background from Transparent to Opaque or
vice versa.

7. We can change both Color 1 and Color 2.

Note : If we hit the enter key at the end of our text, the box will expand
downwards. We can also use the handles to move the text box across the
page, pulling it wider on one side and pulling it in on the other. There is no
way to align our text automatically to the centre, we can put our cursor to
the left of the text and press the space bar as many times as necessary to
centre align the text.
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Uz feg 2aAe 5
Have a nice day!!

Fig. 5.16 Formatting the text

We can also type text in different colors, fonts and size, in the same text
box. When we are making changes, only selected text will be affected. When
we have completed editing of text, we can click anywhere on the page
outside of your text box. After clicking away from the text box, the Text
Toolbar disappears and the text becomes part of our picture. Now, it cannot
be edited in any way.

5.1.3.4 The Eraser

The Erasertool erase the part of a picture with the left button of the
mouse pressed. It changes whatever is dragged across to the background
color - Color 2

Fig.5.17 Eraser

With the right button pressed, the eraser tool changes pixels of Color 1 to
Color 2, but leaves everything else unaffected. We can resize our eraser
with the help of ctrl + '+' button or ctrl + '-' button.

5.1.3.5 The Color Picker

The Color Picker Tool is used to set the current foreground or
background color and to match any color in our picture. It's especially
useful when colors in the picture are different from those on the palette. By
picking a color from the picture, we can make sure that we are using the
color we want when drawing in Paint, so that our colors match.

A

Fig. 5.18 Color Picker

For example we are zoomed in and working with the Pencil tool on an
area that has many shades of red, and we want to use one of those shades.
Click the Color Picker and click directly on the shade of red that we want to
use. The tool will immediately change back to the Pencil, loaded with the
color we want.
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5.1.3.6 The Magnifier

The Magnifier Tool is used to zoom in on a section of our picture.
Magnifier can be clicked over an area of which we want a closer view. The
Left click gives a closer view and Right click zoom out.

Fig. 5.19 Magnifier
5.1.4 Brushes

We can work in various widths and textures with the help of Brushes.
Widths are controlled by the brushes and the Size Tool together; textures
are controlled by the brushes.

Fig. 5.20 Brushes

In the figure shown below lines are drawn with each of the offered
brushes, using the same color and the same line width for each.

e Py Sk [orsenne Sl eceree |
memsesmasmssenemman CA|IGraphy 1 e s

e — cal[igraphy; [ —

airbrush R A

natural pendil

. water color

Fig. 5.21 Lines are drawn withBrushes

5.1.5 Shapes

In the Shapes Gallery, along with Rectangles, Rounded Rectangles
Ellipses and Freehand Polygons, the Line Tool and the Curved Line Tool

(
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can also be seen. There are number of other shapes such as arrows, speech
balloons, various stars and others are also included.

[Efi' [Z7 Outline
| &

Fill
Shapes

*

Shapes
Fig. 5.22 Shapes
We can open the Shapes Gallery by clicking the down arrow under the
Shapes picture and click the shape we want to draw.

N/OOO&A
hNOOODAh
V+rnuzoo
VA

Fig. 5.23 Shapes Gallery
w Straight Lines : Straight lines can be drawn while the left mouse
button is pressed and will use Color 1, those drawn with the right
button will use Color 2. Line will be perfectly straight, If we hold
down the Shift key while drawing a line.

w Curved Lines : Click the "/ Curved Line button to draw a curve.
Click the Outline button and choose Solid Color or a texture of your
choice. Then click under the Size picture and choose a line thickness.

x\%
/..--"‘""

Fig. 5.24 Curved Lines
w Elipses, Rectangles, Circles and Squares : If we want to draw an
exact shape such as a square or a circle, hold the Shift key while we
draw.
w Freehand Polygons : To draw a freehand polygon, click the Polygon
button /4 in the gallery. Hold a mouse button down and draw the
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tirst line of the polygon. Then release your mouse button and click
where you want the next line to end. Keep clicking end points until

we want the last line to finish the shape, then double click
start

Fig. 5.25 Freehand Polygons
5.1.6 The Size Tool

This tool becomes active only after we choose either a Brush or a Shape.
After selecting our Brush or Shape we will find down arrow under
SizeTool and can choose a line thickness. The line thicknesses offered vary
according to the brush we have chosen.

Size

Fig. 5.26 Size Tool

5.1.7 Colors

The Color section of the ribbon has three parts :

1. Boxes showing the active colors - Color 1 and Color 2,
2. The Color Palette

3. The Edit Colors button

1

The Color Boxes :

Col Color Color
2 1

Fig. 5.27 Color 1 selected in Color Boxes  Fig. 5.28 Color 2 selected in Color Boxes

= Color 1 is the Foreground Color, and is always black when we open
Paint.
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= Color 2 is the Background Color, and is always white when we open
Paint.

2. The Color Palette : The two top lines of the Color Palette show all the
colors available whenever we are making a picture. The line of blank
squares at the bottom shows those colors, we have edited during our work.
Once Paint is closed, the edited colors vanish away.

EEEEE EEEm
[ ) ) o
I I

Fig. 5.29 Color Palette
3. Edit Colors : The Edit Colors button takes us into the Edit Colors

dialogue box.

Edit
colors
Fig. 5.30 Edit Colors

The Edit Colors dialogue box is shown in figure below :

Edit Colors.

Baskc coloss:

B EEEEEN

EEEENENE

EEEEEEEN

TIT T =

Cistom colom:

el ol .l il sl

| o i
Dl Chintewm T

M{_f‘ﬂ |

Fig. 5.31 Edit Colors
Here we can click any color on an extended palette and click the Add to
Custom Colors button. Here only one color will be added to the squares

under the palette. To add more colors, we must return to the dialogue box
and add them one at a time.
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5.2. View Tab Ribbon

The following section explains the View Tab Ribbon. It has three main
options : Zoom, Show or hide and Display.

5.2.1 Zoom

Zooming in and out can be used alone or in conjunction with the Zoom
Tool on the Ribbon or the slider on the Status Bar. Zoom in and Zoom out
tools can be clicked repeatedly to get a closer or more distant view. The
100% option brings us back to normal view of the picture.

5.2.2 Show or Hide
This portion of the View Tab Ribbon includes :

= The Show or Hide option for the status bar. The status bar is very
useful while drawing pictures precisely.

= Gridlines are convenient if we want to align shapes accurately.

= Rulers can be turned on or off as per our requirement.

5.2.3 Display

On the Display section, we can click for Full Screen View. We can also
get a Full Screen View by hitting F11. We can come back to a normal view
by pressing the Esc key.

= Thumbnail is active only when we are zoomed in. It helps us seeing
how changes, we have made are affecting our picture in normal view.

( Points to Remember )

1. Many of the tools we use in Paint are found in the Home Tab Ribbon
2. The clipboard menu has three options - Cut, Copy and Paste.

3. The top button, a diamond shape with a line through it is crop. It
helps us crop to our picture so that only the selected area remains.

4. The Eraser tool erases the part of a picture with the left button of the
mouse pressed.

5. Zooming in and out can be used alone or in conjunction with the
Zoom Tool on the Ribbon or the slider on the Status Bar.
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(_Exercise )

Fill in the Blanks using the right option :

1.

The clipboard menu has three options - Cut, Copy and

(1) Paste (2) Move (3) Close (4) Zoom

The top button, a diamond shape with a line through it is

(1) Paste (2) Cut (3) Copy (4) Crop
The ............... tool can be used to draw pentagon.
(1) Triangle  (2)Rectangle (3) Pentagon  (4) Hexagon

The Eraser tool erase the part of a picture with the ...............
button of the mouse pressed

(1) Left (2) Right (3) scroll (4) None of these
Color 2 is used if we press with the ............... mouse button
(1) Left (2) Right (3) scroll (4) None of these

Write down True or False :

A B e

Ellipse tool help us to draw a square.

Eraser tool is used for free hand drawing.

Brush tool is used to spray colors.

Drawing/Work area is place where you can draw pictures.

Text tool is used to add text in a picture.

Short Answer type Questions :

1.

SR

What is Home Tab Ribbon?

Write the name of main parts of Home Tab Ribbon
Write the name of tools available in Tools Menu
What is size tool?

Write about brushes
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Long Answer type Questions :

Explains the section of View Tab Ribbon

Explain the parts of Color section in Home Tab Ribbon
Write about Resize and Skew option

What is Text Tool? How to Formatting the text

Write about shapes menu

A e

Name the following tools :

o,

7 (o Al & P

Name the following Shapes :

A ] O O O &
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LESSON

m Hardware and Software

Objective of this Chapter
6.1 What is Hardware?

6.2 What is Software?

6.3 Types of Software

6.4 System Software and Application Software
6.5 Relationship between Hardware & Software

Introduction

Computer is a type of an electronic machine which stores data, uses it
for future, process it and which can be programmed through instructions.
Computer is a combination of hardware and software which are inter-
dependent. It means without software hardware is limited and without
hardware software cannot be operated properly. To work efficiently

hardware and software needs each other.

6.1 What is Hardware ?

In the computer world, hardware refers to the physical components like
Keyboard, Mouse, Printer, Monitor that make up computer system. Input is
feed and output is received through hardware. Data is stored and
processed on Hardware. Hardware can be touched and sensed.

Features of Hardware :

1. We can touch it.

2. We can feel it.

3. It occupies space.

4

We can process &store data on it.
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System Unil Screen Menitor

Speaker
Speaker

.
LR

Keyboard Microphone

Mouse

Fig. 6.1

6.1.1 Computer Case

The Computer case also known as Computer Chassis or System unit or
Cabinet etc is the usually made up of plastic or metal box that contains the
computer's main parts such as the motherboard, hard drives, etc.

Front of computer case Back of computer case and each connection
_—_= )
] I PS/2 Port o
. - COA0M Keyboard / Mouse . /

, .| 4— Zipdrive
. bay
. % oy diive

- ‘..-.-Power button
- 4= Power light

- ®——__ Reset button

MID! / Game port

ﬁi.\.n.ku..m..-a.--.....-
1!‘! i

Fig. 6.2 Computer Case Views

6.1.2 Motherboard

The motherboard is a sheet of plastic (board) that holds all the circuitry
to connect the various components of a computer system.
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-

-

Fig 6.3 Mother Board

Some of the Hardware components that are connected with
motherboard are :

Hard Drive : Hard drive Or Hard Disk is the main storage media
device that permanently stores all data on the computer.

Video Card : The video card is the device in a computer that outputs
visual information to the monitor.

Processor : Processor is the main part of computer system which
carries out the instructions of a computer program by performing the
basic arithmetical, logical, control, and input/output operations of
the system. It acts as a brain of the computer system & termed as CPU

FAN : Every computer has a cooling fan designed primarily to
prevent the CPU from overheating. Cooling fans may bring cool air
into the computer cabinet and draw hot air out of it.

RAM : It is a type of data storage used in computers that is generally
located on the motherboard. This type of memory is volatile and all
information that was stored in this memory is lost when the
computer is turned off.

Power Supply (SMPS) : The component that supplies power to a
computer. it is also called switched-mode power supply (SMPS).

CD/DVD ROM : Itis used to run CD/DVD in the computer.
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6.1.3 Important points for taking care of Hardware.

If different components of computer are not properly looked after,they

get spoiled very soon. Following points should be kept in mind while

handling Hardware:

1.

o N ok WD

We must keep all the parts of computer clean.

We must cover it after use.

We must not pull cables of computer parts.

We must press keyboard keys gently.

We must not eat anything in the Computer Room.

We must keep Hardware properly

We must handle different parts of computer in a proper way.
We must use soft cloth or brush to clean computer.

We must not clean the equipment while the computer is turned on.

6.2 What is Software

A Computer without instructions is like a car without a driver. It

requires a set of instructions given by us to work on. Sequence of

instructions is called program.

Software is the collection of program that are stored and run on

computer hardware and help user to work on the computer. Software is a

program stored in a storage device. You can make a software or you can get

ready made software from market. e.g. MS Word, Games etc.

Features of software :

1.

2
3.
4

Software has no weight.
We cannot touch it.
A software helps the computer to work.

These are costly.
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A group of instructions is known as Program

Many programs are combined to make up a Software

%

] [ Instruction ) / \ (
Program

L I
Program Software

Fig 6.4

6.3 Types of Software

Software is of two types :
= System Software

= Application Software

6.3.1 System Software

System Software is defined as a collection of programs that control the
operation and internal working of the computer system. It reads data from
input devices and transfers the processed information to output devices. It
works like a manager. It plays an important role in computer. We cannot
take any work from computer without it. Example of system software are-
Operating System, Utility Program, Language Translator.

Features :

1. Itis costly.

It is difficult to generate system software.

2
3. Itis complex. It can be developed by an expert only
4

A computer system cannot work without it.
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il i
Windows o Windows Vistal

Fig. 6.5 System Software

6.3.2 Application Software

It is used for an important task. These are sets of program developed by
programmers in order to perform specific types of jobs like creating the
documents, making calculations, preparing results & reports, creating
graphics, arranging data in an organized way. System software is the need
of every computer but application software can be different for different
computers. Today there are many application software available in the
market. e.g wordprocessor, spreadsheet, presentation tool, graphics
software, database etc.

Features of application software :

1. It depends on user requirement

2. Itis cheaper than system software

3. Graphics, documents, reports are easily created in them.

o = O @

MS Access MS Excel MS Frontpage MS Groove

MS InfoPath MS OneNote MS Outlook MS PowerPoint

= 1% 1% 1=

MS Project MS Publisher MS Visio MS Word

Fig. 6.6 Application software
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6.4 System Software and Application Software

System software is different from Application Software in many aspects.
Let us differentiate the two :

S.No.

System Software

Application Software

1.

System software is compulsory
to operate a computer.
Computer cannot work without
it.

Application software is not
compulsory to operate a
computer. Computer can work
without it.

2. | Itisvery complex.Itcanbe made | It is generally simple. A person

by expertonly. with less experience can made
it.

Itisexpensive. It is cheaper
System software interact | Application software does not
directly with hardware. It | interact directly with
depends on operating | hardware. It depends on
system system software

5. Example : window, Unix etc. Example : MS-Word, MS-Excel,

Paint etc.

6.5 Relationship Between Hardware And Software

For a Computer to produce useful output its Hardware and Software
must work together. Hardware & software cannot work properly without
each other. Hardware components are controlled by software. For example:
when we purchased a new mobile phone & memory card from market they

are hardware's. We upload songs & games on them they acts as software's.

Another example is ATM machine. ATM machine acts as a hardware &
the set of instruction that are followed by machine to operate its functions
are software .in the same way in washing machine, washing machine acts
as hardware & the set of instruction or process by which it rinse & spins

the clothes are known as software.
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APPLICATION SOFTWARE

] L3
SYSTEM SOFTWARE
™ -

HARDWARE

Fig 6.6

( Points to Remember )

1. Parts of computer are called Hardware.

Hardware can be touched and sensed.

@ N

Printer, Monitor, Keyboard, Mouse, Hard Disk are parts of
Hardware.

Set of all programs are called Software.
Software is of two types : System and Application Software.

We cannot touch software.

N o e

MS-Word, MS-Excel, MS-PowerPoint are examples of Application
Software.

(_ Exercise )
1. Fill in the Blanks using the right option :

1. Computer is a product of hardwareand ............... .
(1) Software  (2) Application (3) Program (4) All of these

2. Setof instructions is called ............... .
(1) Software  (2) Hardware  (3) Program (4) Application

3. Group of programs is called ............... :
(1) Hardware (2) Software (3) Processor  (4) None of these
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4.  Software is mainly of ............... types.

(1) Two (2) Three (3) Four (4) Five
5. Computer cannot work without ............... .

(1) Word (2) Excel

(3) System software (4) PowerPoint

Write down True or False :
Other name of software is hardware.

All the instructions given in the form of program are called
Software.

3. We cannot touch Hardware.
System and Application Software are two types of Software.

5. System software is expensive.

Which of the following are Hardware :
Hard disk

CD

Mouse

MS-Paint

Presentation

Keyboard

AN M e

Short Answer type Questions :
What is Hardware?

What is Software?

Name two types of Software.

Give four examples of Hardware.

O B L=

What are the qualities or features of Software?

Long Answer type Questions :

1. Write the difference between Application Software and System
Software.

2. Write a note on Hardware.
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3. What are the points while taking care of Hardware?
4. Define Motherboard. Explain any of its five parts?

(Group Activities)

1. Write the name of the Pictures given below.
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LESSON

Input Devices

Objective of this Chapter
7.1 Input devices
7.2 Uses of Input Devices
7.3 Keyboard
7.4 Mouse
7.5 Microphone
7.6 Scanner
7.7 Web Camera
7.8 Touch Pad
7.9 Bar Code Reader
7.10 Light Pen
7.11 Joy Stick
7.12 Touch Screen
7.13 Track Ball
7.14 Magnetic ink card reader
7.15 Digitizer
7.16 Biometric
7.17 Electronic Signature Pad

Introduction

The computer will be of no use unless it is able to communicate with the
outside world. Input devices are required for users to communicate with
the computer. In simple terms, input devices bring information into the
computer these input devices are known as peripherals since they are
attached with the CPU and memory of a computer system.

CPU alone cannot function. It has many helping devices. These devices
help in its working. Some devices give input to CPU and some receive its
output. Devices which give input to computer are called Input devices. In
this lesson we will study about these devices in detail.
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7.1 Input Device

An input device is a hardware device that sends data to a computer,
allowing users to interact with and control it. Devices that gives data and
Instructions to the computer are called Input devices. Input devices are
needed to give input to the computer.

7.2 Uses of Input Devices

If CPU is the brain of computer then the Input devices of computer such
as key board, mouse, microphone are its eyes and ears, that feed the
information into the computer. We use input devices to give data and
information to the computer.

Generally used Input devices are :
Keyboard

Mouse

Microphone

Scanner

Web Camera

Joy Stick

Light Pen

Touch pad

Barcode reader

Touch screen

Track ball

Magnetic ink card reader
Digitizer

Biometric

Ffr1r 151555551

Electronic signature pad

7.3 Keyboard

Keyboard is most common and very popular device which helps in
inputting data to the computer. The layout of the keyboard is like that of
traditional typewriter. A keyboard has many buttons which are called keys.
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There are some additional keys provided for performing additional
functions. A keyboard is used for typing letters, words, numbers and
special symbols. It is a standard input device. Commonly used Keyboard
or standard keyboard has 104 keys.

Fig. 7.1 Keyboard

Types of Keys : Keyboard has five types of Keys. These are

-

F 5§ 1

Alphabetical Keys
Numeric Keys
Functional Key
Special Keys
Arrow Keys

AIphabet|caI Keys Funct|on Keys Spemal Keys Numeric Key Pad
A%

EEIEEEI -----
IIJI'IIII =] =]c*

|
L

Special Keys Arrow Keys

|

=8 @S .Qi

Fig. 7.2 Keys of Keyboard

7.3.1 Alphabetical Keys (A to Z)

Alphabet keys are used to type characters. These keys are present in the
middle of the key board. All the keys A to Z are called alphabet keys.
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7.3.2 Numeric Keys (0 to 9)

The numeric keys are used to type numbers. These keys are present
below the functional keys. On the right side of keyboard a special pad is
present. It contain 17 keys. This key pad is called numeric key pad. This
pad is similar to calculator, because along with numbers it also has
mathematical signs and enter key. On the left top of the pad, a key named
num lock is also provided. The Key's of this key pad works if num lock is
on. The status of num lock is indicated by the indicator on the keyboard.

7.3.3 Functional keys (F1 to F12)

These are 12 in numbers. These are from F1 to F12. These are located at
the top of the keyboard. The function of these keys can be different for
different program. e.g. F1 key is generally used for help.

|F1|F2IF3|F4IF5IFEIF?IFBIF9 IF1DIF11IF12

Fig. 7.3 Functional Keys

7.3.4 Special Keys

Each special key is used to perform a special function. Some special key
with their functions are mentioned as under :

S.No. Name of Function
Special Key
1 Delete To delete characters written on right side of cursor.
2 Back Space | To erase character present on left side of cursor.
3 Enter To start a new line or to execute the command
4 Space Bar | To insert space between two words or texts.
5 Shift It is used along with other key e.g. when shift and
'a' pressed together will print A.
6 Ctrl It is also used along with other key e.g. in paint Ctrl

and S key when pressed together, they save a file

7 Alt Key It is also used with another key e.g.- alt + F4 are
pressed together to close an open program

8 Caps Lock | When we press caps lock key then an indicator
appears on the key board. It means caps lock is on,
it means capital letters will be written.

Downloaded from https:// www.studiestoday.com



Downloaded from https:// www.studiestoday.com

7.3.5 Arrow Keys

These are used to move cursor. These are four in number. These can
move up, down, left, right. Arrow Keys are used to move the cursor in all
directions.

= [L

Fig. 7.4 Arrow Keys of Key Board

—

7.4 Mouse

Mouse is an important Input device. It is used to control cursor on the
screen. It is a small device. It is also called pointing device. Generally it
has three buttons called left button and right button. Wheel is present
between these buttons called scroll button. It is called mouse because of its
shape. Mouse is rolled over a flat surface. As you move a mouse, the cursor
also moves on the screen in same direction. Now days wireless/cordless
mouse are also in use.

Mouse pad : The pad on which we move the mouse is known as the
Mouse pad.

Fig. 7.5 Mouse
Mouse has following three buttons
w Left Button
= Right Button
= Scroll Button
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7.4.1 Left Button

Generally we use the left button. When we press left button once, it is
called "click" when pressed twice it is called "Double Click".The programs
are opened with double click. While things are selected with single click.

7.4.2 Right Button

When we press right button, it is call right click. It is used to open
shortcut Menu.

7.4.3 Scroll Button

It is just like a wheel fixed in the centre of left and right button of mouse.
It rotates which is called scrolling. It is used to move screen up and down.

7.5 Microphone

It is also called mike and is used to input/record voice. We can give
instructions to computer with the help of mike of our computer. If it has
microphone then we can record our own voice. We can listen recorded voice.
Those users who can not type, can give input to the computer with micro-
phone. Using microphone we can also talk to our friends on the Internet.

Fig. 7.6 Microphone

7.6 Scanner

Scanner is an input device. It is used to add text and picture in
computer. It works like a Photostat Machine. Difference is that Photostat
machine gives output on paper while it saves output in computer. Scanners
of many types and shapes are available in the market.

Fig. 7.7 Scanner
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7.7 Web Camera

Web Camera is used to click photo graphs. We can edit these photos in
the computer. It is similar to camera. Difference is that a camera develops
photo on a film roll and Web camera saves photos in computer. Web
camera is not an expensive device.

Fig. 7.8 Web Camera

7.8 Touch Pad

It is also an input device. Touch pad are used in laptop in the form of a
small panel containing different touch-sensitive areas. It is used in place of
mouse. The buttons of touch pad are similar to mouse left right button
which are up down within touch pad. A touchpad is operated by using
your finger and dragging it across a flat surface; as you move your finger
on the surface, the mouse cursor will move in that same direction, and like
most computer mouse, the touchpad also has buttons below the touch
surface that enables you to click like mouse.
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7.9 Bar Code Reader

A Barcode reader (or Barcode scanner) is an electronic device for reading
printed barcodes. Like a flatbed scanner, it consists of a light source, a lens
and a light sensor translating optical impulses into electrical ones. In every
single business today barcodes are used for different reasons. These are
helpful in stores in order to maintain accurate and updated inventory
monitoring. They can help to determine the price of an item. It is a fixed
input gadget that is used to capture and read information enclosed in a bar
code. This device consist of scanner.

Fig. 7.10 Bar Code Reader

7.10 Light Pen

It is an pointing device. It is just like a pen and is connected to a VDU.
The tip of light pen contains a light sensitive element which when placed
against the screen, detects the light from the screen enabling the computer
to identify the location of the pen on the screen. Light pen have the
advantage of drawing directly on to the screen.

Fig. 7.11 Light Pen

7.11 Joy Stick

Joysticks consist of a base and a stick that can be moved in any direction.
The stick can be moved slowly or quickly . Some joysticks have sticks that
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can also be rotated to the left or right. Because of the flexible movements a
joystick allows, it can provide much greater control than the keys on a
keyboard. It is an input device consisting of a stick. It has lever that moves
in all direction and control the movement of a pointer. It is often used to
play video games and usually have one or more push buttons

Fig. 7.12 Joy Stick

7.12 Touch Screen

A type of display screen that has a touch-sensitive transparent panel
covering the screen. Instead of using a pointing device such as a mouse or
light pen, you can use your finger to point directly to objects on the screen.
For example ATM machine, Smart Phones, Smart Boards etc.

Fig. 7.13 Touch Screen

7.13 TrackBall

Track Ball is an input device that is mostly used in notebook or labtop,
instead of a mouse. This is a ball which is half inserted by moving fingers
on balls, pointer can be moved. Since the whole device is not moved, a track
ball requires less space than a mouse. A trackball comes in various shapes.
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7.14 Track Ball

7.14 Magnetic Ink Card Reader (MICR)

MICR input devices is generally used in banks because of a large
numbers of cheques to be processed every day . The bank's code number an
cheque number are printed on the cheques with a special type of ink that
contains particles of magnetic material that are machine readable. This
reading process is called Magnetic Ink Character Recognition (MICR)

g MEMO

3 PE® 120332 e=00L1;

Fig. 7.15 Micr Reader and Code

7.15 Digitizer

Digitizer is an input device which converts analog information to digital
form. Digitizer can convert a signal from the television or camera into a
series of numbers that could be stored in a computer. They can be used by
the computer to create a picture of whatever the camera has been pointed at.
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Fig 7.16 Digitizer

7.16 Biometric

Biometric is a type of machine by which a person can be uniquely
identified by its body parts like fingerprints, hand, eye etc.

Fig. 7.17 Biometric

7.14 Electronic Signature Pad

It is an electronic device used to capture written signatures and convert
them to digital format.
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( Points to Remember )

Input devices are used to give input to computer.
Keyboard is an input device. It looks like a type writer.
Mouse is used to move cursor here and there.

Scanner is used to add text and pictures in the computer.
Web Camera sends photo graphics in the computer.
Mike is used to record voice in the computer.

Touch pad is used in laptop.

Bar Code Reader is used in Big Stores.

Light Pen : It is a pointing device.

Joy Stick is used to play video games.

(' Exercise )

1. Fill in the Blanks using the right option :

2.

3.

............... is used to click photos in computer.

(1) Headphone (2) Web camera

(3) Speakers (4) None of these

Commonly used keyboard has ................... keys.

(1) 100 (2) 104 (3) 105 (4) 107

Bar Code Reader Consist of ............... .

(1) Sensor (2) Light (3) Heat (4) Magnetic
............... is a pointing device.

(1) Headphone (2) Keyboard

(3) Mouse (4) Web Camera

............... is used to add text and Picture in computer.
(1) Printer (2) Scanner (3) Speakers (4) Mouse

............... keys are used to move cursor in all directions.
(1) Arrow (2) Special (3) Function (4) Numeric
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Write down True or False :

Web Camera produce photos on film roll.
Scroll button is used to move screen.
Joystick is used to control video games.

F1 to F12 are functions Keys.

Gk L=

Delete key is special key.

Short Answer type Questions :
What is an input device ?
Name Six input devices .

Write short Note on Trackball.
Write a note on touchpad.
What is the use of Microphone?
Write a note on MICR.

Give use of web Camera.

® NS =

Where is Scanner used?

Long Answer type Questions :
1. Write note on Keyboard And its keys In Detail?
2. Write a note on Bar Code Reader?

3. What is Mouse? Explain the functions of Mouse Button.
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LESSON

m Output Devices

Objective of this Chapter

8.1 Output Devices
8.2 Types of output devices

8.3 Monitor

8.4 Printer

8.5 Speaker

8.6 Headphone
8.7 Plotter

8.8 Projector

Introduction

Both input & output play an important role to complete a task on
computer, because output allows the user to decide what to do next with
the information. We have learnt in previous chapter about input devices.
Now we will study about various output devices in this chapter.

8.1 Output devices

An output device is any computer hardware equipment used to
communicate the results of data processing carried out by an information
processing system (such as a computer), which converts the electronically
generated information into human-readable form. Output devices are
connected to computer and these are used to show data in term of sound,
text and images. They are used to get result of computer. In other words
these devices get output from the computer.

Uses of output device : Output devices are used to get information from
computer. Whether it can be sound or in text form of that information.
Whatever the computer has done is predicted by output devices.
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8.2 Types of output devices
Every Output device has its own work. Commonly Output devices are:-
Monitor
Printer
Speaker
Headphone
Plotter

Projector

Frvr 5 g

8.3 Monitor

It is most commonly used output device. It is a soft output device which
looks like a television. It shows output on its screen.

Here are two kinds of viewing screen used for monitors.
= Cathode-Ray Tube (CRT)
= Flat- Panel Display

8.3.1 Cathode-Ray Tube (CRT) Monitor

. Many Types of CRT monitors are available in the market. CRT Monitor
size is measured by diagonal length of the screen. Monitors are available in
15",17",19 and 21". Earlier black and white monitors were used but now we
use coloured monitors. Such monitors display coloured pictures.

Figure 8.1 CRT Monitor

There are some disadvantages of CRT :
= Large in Size

= High power consumption

= Heat dissipation
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8.3.2 Flat-Panel Display Monitor:

The flat-panel display refers to a class of video devices that have
reduced volume, weight and power requirement in comparison to the CRT.
You can place them on walls. Current uses of flat-panel displays include
calculators, video games, monitors, laptop computer, graphics display.
Some example of Flat-Panel Display monitors are LCD, LED, Plasma etc

Figure 8.2 Flat Panel Display Monitor

8.4 Speaker

Speaker is an output device. They receive audio input from the
computer's sound card and produce audio output in the form of sound
waves. It is used to listen sounds from computer. You can listen songs from
computer. Speakers are present in different shapes. Generally there are two
speakers attached with one computer.

Fig. 8.3 Speakers

8.5 Head Phone

Sometimes referred as earphones, headphones are a hardware device
that either plugs into your computer (line out) or speakers and allow you
to privately listen to audio without disturbing anyone else.
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Fig. 8.4 Headphone

8.6 Printer

Printer prints output on paper. It is a hard output device. The output of
printer is permanent. Its record can be preserved for long time. Printers of
different types with speed resolution and size are available in the market.
Printer are black and white as well as colored. Colored printers give
coloured printout. These are of three types :

w Dot matrix Printer
= Inkjet Printer

w [aser Printer

8.6.1 Dot Matrix Printer

It is a type of computer printer which uses a print head that moves back
& forth or in up and down motion on the page and print by impact. It
prints by joining dots,. It is cheaper. Its speed is slow. It produces sound
while working. The resolution of its printing is poor.

Fig. 8.5 Dot Matrix Printer

8.6.2 Inkjet Printer

It is a type of computer printer that creates a digital image by throwing

droplets of ink on to a paper. It printing quality is better than dot matrix
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printer. We can print graphical images with a good quality. It is coloured
printer. It is very cheap. It does not produce sound while working. Its speed

is faster than dot matrix printer.

Fig. 8.6 Inkjet Printer

8.6.3 Laser Printer
Laser printer is a electro static digital printer. It produce high quality &

graphics by passing laser beams. These are both black and white as well as

coloured. These are costly. Their speed is fastest of all other printers.

Fig. 8.7 Laser Printer

8.7 Plotter

Plotter is an output device. A device that draw picture on paper based
on command from a computer. Plotter differ from printer in that they draw
lines using a pen. As a result they can produce continues lines where as
printer can only simulate lines by printing a closely spaced series of dots.
Multicolor plotter use different colored pen to draw different colors. It is
used in computer aided designing. Plotter are more expensive than printer.

They are use in engineering applications.
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Fig. 8.8 Plotter

8.8 Projector

A projector is an output device that can take images generated by a
computer and reproduce them on a large, flat (usually lightly colored)
surface. For example, projectors are used in meetings & multimedia
presentations to help ensure that all participants can view the information
being presented.

Fig. 8.9 Projector
There are also many devices that are used for both Input and Output.
For example

1. Digital Camera
2. Pen Drive

3. CD/DVD

4. Modem

5. Fax
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input  output
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Fig. 8.10

( Points to Remember )

1. Output devices are used to get information from computer.

Monitor is a soft output device it shows text and pictures on the
screen.

3. Printer is hard output device. It prints output on paper.

4. Printers are of many types like Inkjet, Dot-matrix and Laser.

(_ Exercise )
1. Fill in the Blanks using the right option :

1. Monitorissoftand ............... is hard output device.
(1) Printer (2) Plotter
(3) Both of these (4) None of these.
20, is used to listen sound from computer.
(1) Printer (2) Speaker (3) Microphone (4) Mouse
3. prints output on paper.
(1) Printer (2) Keyboard (3) Mouse (4) Speaker
4. printer prints by joining dots.
(1) Dot matrix (2) Inkjet (3) Laser (4) None of these
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5. Monitorareof ............... types.

(1) Two (2) Three (3) Four (4) Five
6. Headphones are also called ............... .

(1) Earphone (2) iphone

(3) Both of these (4) None of these

Write down True or False :

Output devices are used to get information from computer
We cannot listen music from computer.

Printer is soft output device.

There is no difference between Printer & Plotter.

A

Nowadays black & white monitor are in use.

Short Answer type Questions :

List the four types of output device?
Write the types of monitor

Where are projector used?

List the types of printer.

S N

Write a note on Plotter?

Long Answer type Questions :

1. Write note on monitor and its types ?

2. Whatis printer? Explain three types of Printer.

3. Write difference between CRT&Flat panel display.
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LESSON

m Introduction to M.S. Word

Objective of this Chapter

91 Introduction
9.2  What is Word Processing
9.3 Features of Word Processing software
9.4 Different Word processing software
9.5 Note Pad
9.5.1 How to start Notepad
9.5.2 Parts of Notepad Window
9.6 Word Pad
9.6.1 How to start WordPad
9.6.2 Parts of WordPad Window
9.7 Ms Word
9.7.1 Special features of Ms Word
9.7.2 How to start Ms Word
9.7.3 Parts of Ms Word Window
9.8 Creating New Document using Ms Word

9.9 Saving a New/Existing Document

9.1 Introduction

Word Processing is the widely used computer application which helps
us to enter text from keyboard on a computer. With the help of Word
Processing, we can create and save documents for future use. Main
purpose of a Word Processing application is to produce documents. Its
major advantage is that the documents can be easily edited before printing

without retyping the entire document.
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9.2 What is Word Processing

Earlier typewriters, either manual or electronic were used to type
documents. In those typewriters, words are print directly on the paper. Text
typed using a typewriter will have to be typed again if it contains errors. If
we used more than one copy of the same document, we have to type
complete text document again in computer. Word Processing software has
changed the way we can create text documents. In Word Processors, text
can be seen on the computer screen, checked for errors and corrected,
before it is printed.

9.3 Features of Word Processing
Various Features of Word Processing are:
1. Documents can be saved for future use.

2. Documents prepared in Word processing software can be checked
for errors before printing.

3. We can format documents as per user's requirement and can give
them better looks.

4. In Word Processing software we can use different fonts and their
sizes in the same document.

5. Documents need not to be typed again as in the case of a typewriter.

9.4 Different Word Processing Software

Various Windows based word processing software packages are:
WordPerfect, Note Pad, Word Pad and Ms Word. WordPerfect is mostly
used by publishing industry because of its more powerful features of
creating print quality documents. Note Pad is used to create simple text
documents without any specific formatting. This feature makes the
document size small and easy to share over networks. But Word Pad is
used to create text documents with some formatting tools with different
font styles, font sizes and bullet styles. MS-Word is widely used for office or
home documents it contains very good formatting features, which we need
for creating attractive documents.
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9.5 Notepad

Notepad is a basic text editor that we can use to create the simple text
documents. It supports few basic formatting features such as font and word
wrap formatting only. We can type and edit text in this application. We can
also use some options like cut, copy, paste, delete, find, replace, go to, date
and time etc. The extension of notepad file is .txt.

9.5.1 How to start the Notepad
Start = All Programs => Accessories = Notepad ﬂ

OR

Type “Notepad” in search bar and press enter button from keyboard.

| |Search programs and files pe ’

Fig. 9.1 Search bar

9.5.2 Parts of Notepad Window
Following are the parts of Notepad Window :

1. Title bar

2. Menu Bar
3. Text Area
4. Status Bar

Menu Bar ———

Text Area

Title Bar Minimize Maximize Close

Status Bar

v

= Ln, Coll

Fig. 9.2 Parts of Notepad Window
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9.6 WordPad

Windows provides one more word processing software named
WordPad. We can create and edit simple text documents in WordPad
application. It also allows us to format our document with different font
styles, font sizes and bullet styles. We can also print the document and do

many more things by using various menus provided by WordPad like:
= Cut, copy, paste, find, replace etc.
= Formatting with fonts, size, style, etc.
= Paragraph setting, alignment, numbering and bullets etc.

= Inserting pictures, drawings, date/time and any other object also.

9.6.1 How to start WordPad

StartE = All Programs => Accessories => WordPad E
OR
Type “WordPad” in search bar and press enter button from keyboard.

| |Search programs and files el [

Fig. 9.3 Search bar

9.6.2 Parts of WordPad Window
Following are the parts of WordPad Window :
WordPad Button
Quick Access Toolbar
Tabs
Title bar
Home Tab Ribbon
Ruler

Text Area

® N o ok N =

Status Bar
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WordPad Button Quick Access Tabs Title Bar Minimize
Toolbar Maximize

Home Tab -
Ribbon o - g B
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Ruler NI 1 2 ity FRERIRY SO0,

Text Area

Status Bar ————p 0% (=

Zoom in zoom out

Fig. 9.4 Parts of WordPad Window

9.6 Ms Word

Microsoft Word is a word processing software package. It can be usedfor
preparing letters, reports, and other documents. These documents can be
saved and edited whenever required in future.

9.7.1 Special Features of Ms Word
Following are the special features of MS Word:

1. Allows us to insert text anywhere in the document.

2. We can erase characters, words, lines, or pages as easily as we can
cross them out on paper.

3. We can cut and copy a section of text from one place in a document
to somewhere else. We can also paste a section of text.

4. We can define various page sizes and margins, and the word
processor will automatically read just the text so that it fits to page.

5. It allows us to direct the word processor to search for a particular
word or phrase. We can also replace one character/word with
another.
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10.

11.

12.

13.

14.

We can change fonts within a document such as bold, italics, and

underlining and can change the font size.
It allows us to embed graphs into a document.

Ms Word allows us to specify customized headers and footers that
the word processor will put at the top and bottom of every page. The
word processor automatically keeps track of page numbers so that

the correct number appears on each page.

It specifies different margins within a single document and to specify

various methods for indenting paragraphs.

It provides the facility of macro which is a list of commands that

save a lot of time.

It helps usin merging text from one file into another file by using
feature Mail-merge.Generating mailing labels is one of the examples

of using merges.

Ms Word provides a facility to check the spelling of words. It puts a

colorful line under the words that are incorrect.

It helps us to automatically create a table of contents and index based

on special codes that you insert in the document.

A built-in thesaurus allows us to search for synonyms without

leaving the word processor.

9.7.2 How to start Ms Word
StartE» All Programs => Microsoft Office = Microsoft Office Word

OR

Type “Word” in search bar and press enter button from keyboard.

| |Search programs and files el [

Fig. 9.5 Search bar
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9.7.3 Parts of Ms WordWindow:

Figure shows the main parts of Ms Word Window :

Quitk Access Tabs Title bar Maxirniza
Toolbar Waximlze
Close

Flle Menu

.

F ] Ay her B E T RO NS o] s paBbC psmmee AAY astice sesao | [y ﬂ::”
Graup (Fony Rl L e O | L T B L e S =P O e
Ribbo gt ) ey . e i Ritmg

Text Area

PageNo Total No. Status Bar Haorizontal Deocument Zoomin
of File of words Seroll Bar View Zoorm out

Fig. 9.6 Parts of Ms Word Window
9.7.3.1 File Menu

In the upper-left corner of the Word window is File Menu. Whenwe
click File Menu, a dropdown , a file menu appears. We can use this menu

to create a new file, open an existing file, save a file, and perform many

other tasks.

Fig. 9.7 File menu

9.7.3.2 The Quick Access Toolbar
Above File Menu is the Quick Access toolbar. The Quick Access toolbar

provides us with access to commands we frequently use. By default Save,

Undo, and Redo appear on the Quick Access toolbar.
b 9-0 3

Fig. 9.8 Quick Access Toolbar
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9.7.3.3 The Title Bar

The Title bar displays the title of the document on which we are
currently working. Word names the first new document as Document1. As
we open additional new documents, Word names them sequentially. When
we save our document, wecan assign the document a different name.

Document? - Microsoft Word
Fig. 9.9 Title Bar
9.7.3.4 Tabs

Tabs are similar to the menu system of MS Word 2003, instead of having
dropdown menus, New Version of MS office created the Tab and Ribbon
system. When we select a tab it will display the Ribbon associated with that
tab. Here everything has been changed into button form. Tabs are task
oriented such as Home, Insert, Page Layout, References, Mailings, Review,
View and within each tab, the related sub-tasks are grouped together.

Fig. 9.10 Tabs
9.7.3.5 The Ribbon

The tabs display Ribbons. In Ribbon there are many buttons that are
grouped into categories such as Clipboard, Font, and Paragraph. In
Microsoft Word, we use the Ribbon to issue commands to tell Microsoft
Word what to do. The Ribbon is located near the top of the screen, below
the Quick Access toolbar. At the top of the Ribbon there are several tabs;
clicking a tab displays several related command (groups). Within each
group there are related command buttons. We click buttons to issue
commands or to access menus and dialog boxes.

do-04la&r Doaument - MigsoftWord
Home  Inset  Fagelmout  References  Malings  Fevew  View
Flomimn cn o x s M BlEEew 2E o0 W
2 o ki { aaBbCcDt | &aBbCcc AaBh(i AaBbCe | 5
MRS SRR AY-A|EEIN (= &2 | vemi (Thesec. Hedagt Hedeg2 E":m
. i e
DO r‘ PET'!;h . Sttt
Font (Group) Ribbon

Fig. 9.11 The Ribbon
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9.7.3.6 Dialog Box Launcher

We may find a dialog box launcher in the bottom-right corner of every
group. Clicking the dialog box launcher gives us access to additional
commands via a dialog box.

Cabitri =11 -
i I e
e S— Dialog Box Launcher

Fig. 9.12 Dialog Box Launcher
9.7.3.7 The Ruler

The ruler is found below the Ribbon.We can use the ruler to change the
format of our document quickly.

Fig. 9.13 Ruler

9.7.3.8 The Text Area

Below the ruler the large area is called the text area. We can type our
document in the text area. The blinking vertical line in the upper-left corner
of the text area is the cursor. It marks the insertion point.(when you type
text)

9.7.3.9 The Vertical and Horizontal Scroll Bars

The vertical and horizontal scroll bars enable us to move up- down, and
across our document simply by dragging the icon located on the scroll bar.
The vertical scroll bar is located along the right side of the screen. The
horizontal scroll bar is located above the status bar.

9.7.3.10 The Status Bar

The Status bar appears at the bottom of our window and provides
informationsuch as the current page and the number of words in our
document.

it eI ==
Fig. 9.14 Status Bar
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9.7.3.11 Document Views

In Word, we can display our document in one of the following five
VIeWs :

= Print Layout : The Print Layout view shows the document as it will

look when it is printed.

w Full Screen Layout : Reading Layout view formats our screen to

make reading our document more comfortable.

= Web Layout : Web Layout view enables us to see our document as it

would appear in a browser such as Internet Explorer.
= Qutline View : Outline view displays the document in outline form

w Draft View : Draft view is the most frequently used view. We can

use Draft view to quickly edit our document.
B8R ==

Fig. 9.15 Document Views

9.7.3.12 Zoom Slider

The Zoom Slider is convenient if we are working in a zoomed-in view
and want to zoom out. However, we cannot zoom in on a particular spot

using zoom slider, as we can do with the Magnifier.

100% = —})— @
Fig. 9.16 Zoom Slider

9.7.3.13 Work Area

Free space is called work area. It is used for typing our text.

9.8 Creating a New Document
To create a new document, follow one of the following methods :
1. Click New Option in File Menu.
2. Choose Blank Document Option.
3. Click on Create Button.
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Fig. 9.17 Creating a New Document
OR
Press CTRL+N keys on the keyboard.

= Open an Existing Document : To open an existing documents use
one of the following methods :

Click on Open button from File Menu at the top left corner of our
screen to open an existing document.

OR
Press CTRL+O keys on the keyboard.

Each of the above method will show the Open dialog box. Choose
the file and clickthe Open button.

9.8 Saving a New/Existing Document
To save a new or existing document that isopened, follow one of the
following methods :
Click the Save Option available on File Menu.
OR
Press CTRL+S keys on the keyboard.

If the file is a new document then it will prompt us by opening Save As

dialog box.
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Fig. 9.18 Save As dialog box

Select the folder where we want to place ourdocument, type the name of
thedocument in File Name: box and then click SAVE. On the other hand if
the document is already saved with a name earlier, it will simply save the

document.

( Points to Remember )

Documents need not to be typed again as in the case of a typewriter.

Notepad is a basic text editor that we can use to create the simple
text documents.

WordPad allows us to format our document with different font styles,
font sizes and bullet styles.

Tabs are similar to the menu system of Ms Word 2003, instead of
having dropdown menus new version of Ms Word created the Tab and
Ribbon system.

A dialog box launcher in the bottom-right corner of every group

Below the ruler the large area is called the text area. We can type our
document in the text area.

The Print Layout view shows the document as it will look when it is
printed.
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8. Draft view is the most frequently used view. Weuse Draft view to

quickly edit our document

( Exercise )

Fill in the Blanks using the right option :

1.

Ctrl+Sisused to ............... .

(1) Save (2) Open

(3) New (4) Close

Below the ruler the large area is called the ............... .

(1) Text Area (2) Open Area

(3) Close Area (4) All of these

There are two scroll bars in a word document ............... and
(1) Horizontal, Vertical (2) Left, Right

(3) Upper bar, Lower bar (4) None of these

To open a new document Press ............... keys on the keyboard
(1) Ctrl + O (2) Ctrl + N

(2) Ctrl +S (4) Ctrl +V

The ............... view shows the document as it will look when it is
printed.

(1) Print Layout (2) Draft

(2) Outline (4) Full size

Write down True or False :

1.
2.

A dialog box launcher in the bottom-right corner of every group

Notepad is a basic text editor that we can use to create the simple
text documents.

Title bar is the bottommost bar of the Word window

Outline view displays the document in outline form
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Short Answer type Questions :

How to start the Notepad ?

List the Parts of WordPad Window.
What is the Office Button ?

Define Dialog Box Launcher

Define the Text Area.

What is the Status Bar ?

AN N O e

Long Answer type Questions :

1. Explain any 6 Special Features of Ms Word
2. Explain Document Views in Ms Word

3.  How to creating and Saving New Document in Ms Word ?
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